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INTRODUCTION:

· The Offline Image Viewer (OIV) is an image presentation tool.  It is a piece of software that can be used offline – so you don’t have to be connected to the Internet.  The Offline Image Viewer is created and offered by ARTstor, a database of digital images.  Thus, you can use the OIV to present high-resolution ARTstor images offline.  However, the OIV can also be used exclusively to present your own collection of images, be they direct digital capture, scans, or images you’ve pulled from the Web, etc.  Hence, the OIV can be used in 3 different ways:

· To only present your own image collections

· To only present ARTstor images

· To present both local images collections and ARTstor images side by side

· OIV is an application that needs to be installed on the machines from which you will be presenting.  The Museum’s IS&T Department has policies in place whereby staff are not allowed to install software.  Watson Library and IS&T are working together so that, after you have taken this class, I can give your names, with you permission, to IS&T staff who will then set-up appointments with each of you to install the OIV on your Museum desktops and/or laptops.  Please do not call the Help Desk directly for this.  


· If you would like to have the OIV installed, please email or call Deborah Vincelli (x2912).

· Since the OIV is an ARTstor product, in order for it to be installed by our technicians, it needs to be grabbed from the ARTstor live site.  Each user gets their own licensed copy of the OIV.  Thus, each user does need to have an account with ARTstor.  This is an instruction the technicians will have, but if you are already registered with ARTstor before they come to do the installation, it will save some time for everyone. 


· Thus, even if you never plan to use the images in the ARTstor database, in order to use the OIV, you do need to register in ARTstor.  It’s a simple, one-time registration procedure:

1) Access ARTstor at http://www.artstor.org/
2) Click on Launch on the Right.

3) Click on the Register button on the extreme right.

4) In the ARTstor User Registration form, enter and confirm your Museum email address, or you may also use a personal email account.  Enter and confirm a password.  (Create your own password but make sure it is a minimum of 7 characters).  

5) When the form is completed, click on the gray Register button on the bottom left.

6) You will then get a message indicating that you have successfully registered.  

(    Once you’ve registered in ARTstor, the next thing you should to do is give yourself 

      “Instructor Privileges”.  Though instructor privileges are not needed to download     

      the OIV, they give you access to the highest level of functionality in ARTstor and 

      might be something which you might find useful at some point when using the 

      ARTstor database.  Giving yourself instructor privileges is a one-time procedure and 

      the Museum has an institutional username and password that staff only can use.

1. In ARTstor, go to the TOOLS menu at the top.  

2. Click on “Obtain Instructor Privileges” from the drop-down menu.
3. Enter the authorization code and password for your institution.

OVERVIEW OF WHAT YOU CAN DO WITH THE OIV:


Though the OIV does work a lot like PowerPoint, a Microsoft presentation tool, the OIV was designed specifically to present images.  It thus has extra functionality to this end, mainly:


· The ability to create side-by-side image comparisons on the fly   
· The possibility of zooming in on an image during your presentation – i.e. in “real time”
· The flexibility of deciding whether or not to display text next to an image as you are presenting it  
       (    In addition, you can also create customized slides with images and text.  You can  

             compare up to 4 slides on the screen using the OIV’s pre-set slide templates.  If 

             you use the blank slide template, you can compare as many images as can fit on 

             a slide.

N.B. The OIV Help File is very useful.  You can access it from the OIV itself by going to the Help menu, and then selecting “Help Topics”.

APPLICATION:

The OIV is composed of three panels; the Image Palette, the Slide Editor and the Slide Sorter.  You can minimize, maximize, resize and hide these panels as you see fit by using the icons in the top right corner of each palette.  To restore your workspace to its original layout go to View in the top menu, click on Workspace from the drop-down menu, and then click on “Reset to default layout”.
The Image Palette:


· The Image Palette is the place where you import your images and then manage them.

· You can import local images and/or download ARTstor image groups.  You can now also import an entire PowerPoint presentation into the OIV – see pg. 17.

Importing local images:  

· Click on the “Import local images” icon at the top left of the Image Palette.  

· Browse to the location on your computer where you’ve saved your local images, i.e., your desktop, hard drive, CD, etc.  

· Select images and click on ADD.  You can import images in a batch by clicking and holding down the Shift key, or using the Control key to select specific images.  By adding an image to a presentation, the Offline Image Viewer will make a copy to store in your presentation.  Your original file will remain in place in your local drive.  Please note that the OIV is currently only accepting JPEG files.  If your images are saved in another format, you have to resave them as JPEGs.  Simply renaming a file with a JPEG extension will not work.
· The selected imported images are added to the Image Palette. 

Editing local image data:


· Once your local images have been imported into the OIV, you can edit the data that accompanies them.  You do this by right-clicking on a thumbnail in the Image Palette and selecting “Edit image data”.  You’re then presented with a series of fields that you can populate as you see fit.  (To get more text boxes for a field, simply click on the + sign next to it.)  Once you are finished keying in your data, click on the "OK" button at the bottom of the window to save your changes.

(    When using the Image Palette, you can decide during your 

      presentation whether or not you’d like this data to display.
Downloading ARTstor images:  


If you have created image groups in ARTstor, you can download the 

images from those groups into the Offline Image Viewer for a presentation.  

You cannot download images from ARTstor into the OIV unless you have 

saved them in an image group within ARTstor.


· Click on the “Download image group(s) from ARTstor” icon at the top left of the Image Palette.  

· You will be prompted to logon to ARTstor with your ARTstor account information.  (Even though you will ultimately be presenting these ARTstor images offline, you do need to be connected to the Internet, and within the Museum’s IP range, to download the image groups.)

· You will next be shown the list of ARTstor folders into which you’ve saved your image groups.  (This is the same list you would see if you were using the ARTstor database directly.)

· Double-click on the folder that contains the image group you wish to download.  Click on the selected image group and select the “Download” button. 

· A progress bar will appear, indicating the title and file size of the images that are being downloaded from your group. 

(    N.B.  When you use the ARTstor database you can download an image to 

      be used outside of ARTstor, like in PowerPoint, for instance.  However, 

      the image will download as a low-resolution file, at approximately 384 

      pixels on the long side.  When you download ARTstor images into the 

Offline Image Viewer, however, you’re downloading them at 3200 pixels x 3200 pixels.  

Displaying ARTstor image data:


· You cannot edit the data that accompanies ARTstor images. When you right-click on the thumbnail of an ARTstor image in the Image Palette, the “Edit image data” option is grayed out.  When presenting these images you can, of course, simply choose to not display the data.  

· In the ARTstor database, you can add commentary to the object record that accompanies an image.  If you have done so, you will be able to display that commentary when you present those ARTstor images in the Offline Image Viewer.  

Ordering and Displaying your results in the Image Palette:

Once you have imported all the images that you wish to work with into your Image Palette, you can SORT them in the order that you wish to present them.  To sort, just click and drag the thumbnail you wish to move.

You can also display your thumbnails in three different ways by using the icons in the Image Palette menu bar:  

1) Thumbnails with captions; title & artist.  (This is the default display option).

2) Thumbnails only.

3) Thumbnails with a brief data record.

N.B. These display options only affect your workspace within the Image Palette, they do not affect the display of your presentation.

Presenting from the Image Palette:

You can present images directly from the Image Palette.    

· Click on the “View Image Palette Presentation” icon to launch the presentation.

· N.B. You will notice that the OIV will begin “caching” your images.  Because some of these image files are large, this caching activity can sometimes cause a small delay in starting up your presentation.  Hence, you might want to launch the presentation before your audience starts coming into the room, so that this caching can happen beforehand, and you are ready to start with the first image.

· All images in the Image Palette mode are presented against a black background.  No customization is necessary.

· TOOLBAR: 
You can use the toolbar that appears at the top left of your presentation to navigate through the images.  You can also hide it by right-clicking and unchecking “Show Toolbar”.  You can then either use the keyboard shortcuts (available from OIV Help File) or right-click and use the menu options to navigate through your presentation.


· FUNCTIONS:
Here are the various functions that can be performed during your presentation using the toolbar, keyboard, or shortcut menu options.


· Proceed to the next or previous image in your presentation sequentially.  

Keyboard commands: 

Space = Next image
Shift+Space = Previous image

Page Down = Next image

Page Up = Previous image

· Jump to any image within your presentation.


Keyboard command: 

F5


· Display data in brief or full format.

Keyboard commands:

F1 = Brief data.  Press F1 again to hide.

F2 = Full data.  Press F2 again to hide.

· Split screen in half, horizontally or vertically.

Keyboard commands:

H = Horizontal split
V = Vertical split
F = Full screen

Use mouse or TAB key to toggle between screens.

*** When you split your presentation screen, each half acts independently of the other so that you can perform different functions on each side.  For example, you can move forward in your presentation on the left side of the screen, and backwards on the right side, or, you can jump to an image out of sequence on the left side, while keeping the image on the right side of the screen fixed.  You can also view the same image on both sides of a split screen and, while keeping the full image fixed on one side, zoom in on a detail on the other side.

· ZOOM IN on an image and PAN & SCAN around the magnified area of the image.

You can zoom by left-clicking with your mouse into the image.  To pan the magnified area, hold down the left-side of your mouse and drag your mouse over the area.

Keyboard commands:

+ = Zoom into an image 
- = Zoom out of an image
Use the arrows keys to pan within an image: Up, Down, Left, Right.

· View image in actual size (1:1 ratio).  To view an image in its largest possible size (up to 3200 pixels on the long side for ARTstor images), use the right-click shortcut menu, select the "Display" option, and then click on "Actual Size".  This view will allow you to see the greatest amount of detail within the image, before the image begins to pixelate.  You can also click on the 1:1 toolbar icon to view your image in actual size.  

N.B.: While you are zooming into an image, you may notice that the color of the 1:1 toolbar icon changes from green ([image: image1.png]


) to red ([image: image2.png]


).  The change to the color red represents a warning that you have zoomed past the Actual Size of the digital file.  You may continue to zoom into the image, but the color change is a warning, indicating that the image may begin to pixelate past this point and the image quality may deteriorate as you continue to zoom.


Fit to frame: After zooming into an image or enlarging it to "Actual 

Size", you may want to return to the default "Fit to frame" view.  In 

order to resize the image so that it will fit, in its entirety, in the space 

allowed – whether the full screen, or half a screen when it is split 

horizontally or vertically - choose the "Fit to frame" option from the 

right-click shortcut menu under the "Display" option.

Keyboard commands: 
9 = Actual size
0 = Fit to frame


· The Image Palette presentation gives you a lot of flexibility that you don’t get with PowerPoint.  Because every image is dynamic, you can make more decisions on the fly.  You don’t have to plan your side-by-side comparisons ahead of time since you can decide to split your screen during your presentation and easily move to whatever images you need to compare.  You also don’t need to plan your image detail captures ahead of time since you can zoom in on every image in your presentation in “real-time”.  In addition, you can choose to hide or display object data as you see fit during the course of your presentation.

The Slide Editor:  


The Slide Editor is the area where you create and customize slides using the 

images from the Image Palette.  If you’re happy presenting directly from the Image Palette, then you don’t have to use this other part of the Offline Image Viewer.  If you want to create customized slides however, as you do in PowerPoint, then you should use the Slide Editor.

Start by inserting a slide, be it a blank slide or one of the slide templates.


Inserting a Blank Slide:


· Click on the “Add a slide to this presentation” icon in the Slide Editor menu.

· You’re then given a choice of templates.  Select the blank slide.  (Note that when you insert a slide in the Slide Editor, it automatically appears on the left in the Slide Sorter, which is where you can ultimately sort all of your finished slides.)
· The blank slide template has no image or text placeholders – you have to add those yourself using the Slide Editor menu icons.


Adding an image placeholder to your slide:

· Click on the “add an image” icon.  A placeholder will appear.  You can move the image placeholder around the slide by clicking and dragging it, and you can change its size by clicking and dragging the blue square handles.

· Click and drag a selected image from the Image Palette into the Image 

placeholder.  N.B. If you want the image to fill as much of the image 
placeholder as possible, without zooming in on it, right-click on the image and then select “Fit to frame”.  If the image has moved within the placeholder area, “Fit to frame” also repositions the image to the center of the placeholder.


· The Arrow icon in the Slide Editor menu will move the entire image placeholder around on the slide, but if you want to move just the image itself within the placeholder click on the Cross icon, the one that says “Pan the selected image”.  Notice that the image can be cut-off if it goes beyond the limits of the placeholder.  To re-center it, click “Fit to frame”.

· If you want to capture a magnified detail of an image you can use the zoom option in the Slide Editor (+ - icons).  Please note that this is not a “real-time” dynamic zoom that is happening during your presentation, but a static detail that you’re capturing ahead of time as you prepare your slides.  In this aspect, the Slide Editor is similar to PowerPoint.  Use the + icon to zoom in and the – icon to zoom out.  Selecting “Fit to frame” will restore the image to its original size & recenter it.  


· Increasing the Slide Workspace Area:  
You can increase your working area on the slide, so that you can see things more clearly, using the Sliding Bar on the top right of the Editor.  This will just increase your working area in the Slide Editor, not the size of the slide or the image to be presented.  (If you do not see the Sliding Bar, click on the double right-pointing arrows.  Also, when using the Sliding Bar, it’s best to maximize the Slide Editor panel.)

Adding a text box to your slide:

· Click on the “add an text box” icon.  A text box will appear.  You can move the text box around the slide by clicking and dragging it, and you can change its size by clicking and dragging the blue square handles.


· You can add any text you want here of course; you can make up your own text, or you can copy and paste the data that accompanies the image in the Image Palette.

· To copy and paste data, right-click on the selected image in the Image Palette and then select “Display Image Data” from the menu.  A separate data window will open.  You can then copy the data you want to display (using Control-C) from this window, and paste it (using Control-V) in the text box on the slide.


· A simpler way of doing this is by simply dragging the selected image from the Image Palette right into the text box on the slide.  This will automatically populate the text box with the object data that accompanies that image.  You will be given the option to select which data fields from the object record you wish to display in the text box. 


· You can format the text size, font, style, color and alignment.  Highlight the text you wish to format and click on the “F” icon in the Slide Editor for the various options.  N.B. If you see a green arrow in the text box, it means that not all your text is visible and you need to either expand the size of the text box or decrease your font size.

Further things you can do to customize your slide:


· The Image and Text placeholders are called the segments of your slide (they’re the different pieces that make up your slide).  You can put as many image and text placeholders as can fit on a slide.


· You can change the background color of your segments and select the opacity of the color.  You can also add a border to your segment, selecting its thickness, color and opacity.  To make these changes, click on the segment and select the “Edit the properties” icon at the top of the Slide Editor, or right-click and select “Properties” from the shortcut menu.  

· You can also change the background of the entire slide.  Right-click on an area of your slide outside of your segments, and select “Slide Background” from the shortcut menu. 


· Adding a shape:
You can add a shape to your slide.  While designing your slide, you may find the need to highlight certain portions of an image or a text box.  You can create a shape to point to this area, whether a circle, square, or arrows.  To place a shape on your slide, click on the “Add a shape” icon in the toolbar at the top of the Slide Editor.  (You can also right-click on the area of your slide outside of your segments, and select “Add a shape” from the shortcut menu.)  Once you do so, a small window will appear, prompting you to choose the desired shape.  Choose a circle, square, or directional arrow, and then click the "OK" button.   

You may add multiple shapes to the same slide using the same steps.  For instance, you may want to encircle a detail within an image, while also using an arrow to point a text box to that shape.

Moving and re-sizing shapes:
Once you have added a shape, it will appear on your slide, surrounded by a dashed outline.  You can move the shape around the slide by clicking and dragging it, and you can change its size by clicking and dragging the blue square handles.  With a square, you can drag the sides to create rectangles of various lengths and widths.  Dragging the corner of a circle will increase/decrease the circumference of the circle, while moving a side handle will create an ellipse.  With arrows, dragging a corner handle will increase/decrease the length of the arrow.  

Formatting shapes:

You can format a shape’s appearance by giving it a color, creating a fill effect, or determining its thickness and opacity.  Click on your shape to select it. Then, right-click on the shape and select the "Properties" option from the shortcut menu.  A new window will pop up prompting you to select a color and a thickness for the outline of your shape, as well as an opacity level.   

You may set the level of opacity for your shape by using the sliding arrow in the "Opacity" field.  Setting the opacity level to a lower value will create a semi-transparent shape.  Setting the opacity level to a higher value will create a more opaque object.  The opacity level is important to consider when deciding whether or not to add a fill effect to your circle or square.  If you check the box next to the "Filled" option, your circle or square will be filled with the color that you have chosen.  This option will fill the entire area outlined by your circle or square with a solid color.  N.B. If you would like to overlay this filled shape onto another object, you might consider decreasing the opacity level.  If a filled shape is completely opaque and is placed over another item, it will cover that portion of the object.
Deleting shapes:

To remove a shape from your slide, you have to select the object by clicking on it.  (You will know that it is selected when it is surrounded by a dashed outline and 8 square handles.)  If you would like to select more than one shape to delete, hold down the “Shift” key while clicking with your mouse on the desired objects.  When you have made all of your selections, click on the “Delete selected object(s)” icon ([image: image3.png]


) in the toolbar at the top of the Slide Editor.  You can also select the "Delete selected object(s)" option from the right-click shortcut menu, or press the "Delete" key.

 


Changing the order of your slide segments:

 I.E. “Animating a slide”

· When you present slides with different segments (i.e. your text and image boxes), you can choose to show the entire slide as a unit, or have each segment “slide-in” individually.  In order to determine the sequence in which the segments “slide-in”, right-click on a segment and then select “Order” from the drop-down menu.  You have 4 options which allow you to adjust the way the segments layer on top of one another in the Slide.  One thing to remember is that the segments at the bottom of the stack will appear first and the segments on top of the stack appear last.  So the segments appear in the order that you’ve layered them, but from Bottom to Top, or Back to Front.

Order options:
○    Bring forward = this moves the segment down one in the sequence.
· Bring to front = this segment will appear last because it’s on top.

· Send backward = this moves the segment up one in the sequence.

· Send to back = this segment will appear first because it’s on the bottom.

During your Slide Presentation, you will be able to introduce the next and previous segments of your slide by using the "Shift-Right Arrow" and "Shift-Left Arrow" keyboard shortcuts, respectively.  This will introduce the segments separately, one-by-one, so that the items at the bottom of the stack will appear first.  The other items will follow in the order that you layered them, from back to front.  If, at any point, you want to show the entire slide at once, rather than each segment separately, use the Space bar to advance to the next slide and the "Shift" key with the Space bar to view the previous slide.


Inserting a Slide Template:


            The difference between presenting from the Slide Editor and presenting from 

            the Image Palette is that in the Slide Editor you have to plan in advance the 

            type of slide you want to show – and then choose the right slide template 

            accordingly.

For example, if you want to compare more than one image on a slide, you have to 

plan that in advance by either customizing a blank template with more than one image placeholder, or choosing an appropriate ready-made template.  The same applies if you want to add text to a slide.  N.B. All the slide templates, like the blank slide, are customizable.  You can change the positioning and size of the various segments on the slide, as well as add more segments to the selected template.

Inserting a ZOOMABLE SLIDE:

In the Image Palette presentation, every image is zoomable.  However, when presenting from the Slide Editor, if you want to zoom-in on an image, you have to have selected the zoomable slide templates.  (It is not possible to create a zoomable slide using the Blank Template.)


· Click “Add a slide”, then select any of the templates that have the image of a magnifying glass over them – these are the zoomable slides.  Drag and drop your selected image into the slide.  These slide templates will allow you to zoom in on your image during your presentation and to pan and scan it.  


· In the Slide Sorter your zoomable slides are indicated by the silhouette of a magnifying glass on the slide.  During your presentation, you’ll be able to tell which are the zoomable slides, because your mouse cursor will change from an arrow to a circle (it’ll look like a small magnifying glass).


· Thus, it is possible to have a “dynamic” zoom in the Slide Editor presentation, the way you do in the Image Palette presentation, except that you have to have planned which images you’re going to zoom-in on in advance by selecting the zoomable slide templates.  You therefore have less flexibility during the presentation itself.


The Slide Sorter:

As you create slides in the Slide Editor, they appear automatically in the Slide Sorter.  The Slide Sorter is where you can re-arrange your slides in the order you want to present them.  Just click and drag the slides you wish to re-order to their designated spot.  You can also delete slides in the Slide Sorter.  Highlight the slide and then either select the “Remove slide(s) from this presentation” icon from the Slide Sorter toolbar, or right-click and select “Remove slide(s) …” from the shortcut menu.

Presenting from the Slide Editor:

Some of the functions and commands are the same as when presenting from the Image Palette, and others are different.

Click on the “View Slide Presentation” icon from either the Slide Editor or Slide Sorter.  When the presentation launches, a quick guide with keyboard shortcuts will appear on top of the first slide.  If you want to suppress this guide during your presentation simply uncheck it.  And if you want to bring it back go to View in the top toolbar of the OIV, select “Dialogs” from the drop-down menu and click on “Show presentation quick guide”.
Unlike the Image Palette, you have no toolbar to help you navigate in the Slide Editor presentation.  Hence, your options are to right-click and select menu options, or use keyboard shortcuts.  (Right-clicking only provides options for Next Slide, Previous Slide, and Exit Presentation (ESC).  The keyboard shortcuts give you many more navigation options.)

FUNCTIONS: 
Here are the various functions that can be performed during your Slide Editor presentation using the keyboard shortcuts.

* = same command used in the Image Palette presentation.
· Proceed to the next or previous image in your presentation sequentially.  

Keyboard commands: 

Space = Next image *
Shift-Space = Previous image *

Page Down = Next image *
Page Up = Previous image *


· Introduce the segments of your slide separately, one-by-one, from bottom to top. 

Keyboard commands:

Shift-Right Arrow  =  View the next segment in a slide
Shift-Left Arrow = View the previous segment in a slide

If, at any point, you want to show a slide with segments all at once, (in its entirety), rather than each segment separately, use the Space bar to advance to the next slide and the "Shift" key with the Space bar to view the previous slide.

You can switch back and forth between these two methods of displaying your slides - separate segments or entire slides - by using these keyboard shortcuts.

· Zoom-in on a Zoomable Image Slide:
(You can zoom-in to an image by left-clicking with your mouse, or using the following keyboard commands.)

Keyboard commands:

+  Zoom into an image *
 -  Zoom out of an image *

Use the arrows keys to pan within an image: Up, Down, Left, Right.
You can also pan by clicking and dragging your mouse over the image.

9 = View image in Actual Size *
      0 = Resize image to Fit to frame *

Compare 2 modes of presentation; the Image Palette presentation and the Slide presentation:  

How do you decide which mode of presentation to use?  They each have their advantages and you have to use the mode that best suits your presentation style.

Image Palette Presentation:
Advantages:

You have more flexibility.  Because every image is dynamic, you can make decisions on the fly.  You can decide to zoom in on any image in your presentation without having planned this in advance, or prepared any screen captures of details.  You can also decide during your presentation which 2 images you’d like to compare on the screen; if an audience member asks you to compare image x to image y, you can accommodate them by splitting your screen, and then jumping to any image within your presentation in either screen.  Essentially, any impromptu combination of 2 images can be displayed when the screen is split.

You also have more flexibility concerning displaying text during your presentation.  You don’t have to prepare the text in advance, and you can decide during the presentation whether you want to present it in full or brief, or not at all.

The Image Palette Presentation is also less work and preparation.  You don’t have to worry about customizing anything.  You can simply assemble a group of images in the Palette and they’re ready to be presented immediately.

Disadvantages:

In the Image Palette presentation, you can only ever have two images on the screen at the same time.  (You can only split the screen once).

Also, the images are pre-cached as the presentation is launched to optimize the transition time from image to image.  Depending on the size of your presentation, this may cause a small delay during startup.

Slide Presentation (presenting from the Slide Editor):
Advantages:

You have the option to customize your slides in various ways.  

You can display any kind of text you want by adding text to a slide.  In the Image Palette mode the only text you can display is the object data.  (Of course, if you’re showing local images, then you can edit that object data.)  


You can add a sense of drama to your presentation by introducing different segments of your slides one-by-one and thus “animating” an otherwise static slide.

You can add any number of images to a single slide.  (You’re not limited to 2, as in the Image Palette).  

There is no caching time needed to present your images, thus avoiding a lag time as you launch your presentation.  Since the slides are static, the transition time between slides is minimal.

Disadvantages:

Since each slide is static, you have to prepare every aspect of your presentation in advance, and cannot made decisions on the fly during the presentation itself.  Thus, there is less flexibility and more preparation involved since each slide has to be created, designed and edited before you present it.

For example, all of your image comparisons have to be prepared beforehand and mounted on the slide in the Slide Editor.  You also have to make decisions beforehand about which images you’d like to be able to zoom into, since you have to select the zoomable slide template.  

Your navigation is limited during the presentation – you can move to the next or the previous slide, but you can’t jump out of sequence.

Saving your presentation:

There are 3 different ways you can save a presentation that you’ve created in the Offline Image Viewer.  The options are available from the File Menu in the OIV top toolbar.  Click on “Save as” from the drop-down menu.

1) Save with a different name:  
This allows you to save your presentation under a different name and have two copies of it.  Notice the file extension is a .prs.  That’s the extension for saving your presentation as a working copy.  This means that you are saving both the slides that you created in the Slide Editor, and the images from the Image Palette.  It is saving the whole thing, which will create a large file, but one that you can go back to and edit.  It is recommended that you always save a working copy of all your OIV presentations.


2) Save Read-Only Slide Presentation:
After you have saved a working copy of your presentation, if you want to create a smaller file for presentation purposes, (i.e. a file which will give you shorter load times in between slides), you can save it as a read-only file.  This file will have the extension .shw.  

a. Select “Save Read-Only Slide Presentation”  
b.   You’ll be prompted to select a compression level; if you choose very 

       high quality, you will have high-resolution, uncompressed images, but 

       a very large file with slow load times.  If you choose low quality, 

       you will have highly-compressed images creating a smaller file and 

       quicker load times, but the quality of the images will not be as high.  

       Medium quality/compression level is recommended for presentations 

 with about 25-30 slides.


      N.B. When you open a read-only file, you won’t see the Image Palette, 

      since you’re not supposed to be able to edit the presentation.  With a  

      read-only file, you can only present slides.  You cannot present from the 

      Image Palette.

3) Save Image Palette only:

This option allows you to share the images from your Image Palette collection without having to share your presentation slides as well.  None of the slides that you created from this collection of images will be exported.  This presentation file, which will only contain the images from the Image Palette, will be saved as a .prs file.

AUTHENTICATING THE OIV & REMOTE ACCESS TO ARTSTOR:

ARTstor allows its users to access their ARTstor account remotely, that is, from a computer outside the Museum.  ARTstor offers a “remote access grace period” of 120 days.  This means that, if you login to your ARTstor account today from within the Museum, then for the next 120 days you will be able to access your ARTstor account from any computer in the world connected to the Internet.  

If the Offline Image Viewer has been downloaded to your laptop, you will be able to present images using the OIV anywhere in the world.  However, to ensure that you’re a legitimate user from a subscribing institution, ARTstor asks that when the OIV software is used remotely, (i.e. not within the Museum), it must be authenticated every 30 days.

To Authenticate the OIV every 30 days:

· You have to be connected to the Internet.
· You have to be either within the Museum, or accessing ARTstor outside the Museum within the 120 day window for remote access.
· In the OIV, go to the Help file in the top toolbar.  Click on “Authenticate OIV” from the drop-down.  
· You will be prompted when your OIV is about to reach its 30-day expiration, so that you can authenticate it in a timely manner.
What happens if you don’t authenticate your OIV remotely every 30 days?  

· You will still be able to present your own images.
· The ARTstor images will not be available for display.  Once you do authenticate the OIV, then the ARTstor images will become visible again.  It is not necessary to download them again from ARTstor into the OIV.  

Printing from the OIV:

You can print from both the Image Palette and the Slide Editor.

1) From the File menu in the top toolbar, select Print.

2) Chose Slides or Palette images.  (You can print 2 or 4 slides per page.)

Importing a PowerPoint presentation:

With version 2.6 of the OIV, you will be able to import an existing PowerPoint presentation and convert it into the OIV format.  When you import a PowerPoint presentation, your slides will be converted into Offline Image Viewer presentation slides, while the images contained on your PowerPoint slides will be imported into your image collection in the Image Palette.  

1) Go to the "Insert" menu in the OIV top toolbar and select the "PowerPoint    

      Presentation..." option.  You may also click on the "Import PowerPoint  

      presentation" icon in the upper left corner of the Image Palette pane.

2) A new window with your computer's directory will open.  Browse to the  

      location of your PowerPoint presentation, select the desired file, and then 

      click on the "Open" button.

3) A small window will track the progress of the import.  Your original 

PowerPoint presentation file (.ppt) will remain in its location, while its contents will be copied and imported into a new OIV .prs file.

 

Please note that while the text and images from your PowerPoint slides will be converted into the Offline Image Viewer format, other elements such as design templates, charts/graphs, slide transitions, animations, audio/video files, etc. will not be carried over. 

4) Once the import process is complete, you will see your slides listed in order in 

      the Slide Sorter pane.  You may click on any of these slides to begin editing it   

      in the Slide Editor, so you are not bound to the original design or content of 

      the former PowerPoint slides.  

5) You will also notice that all of the image files that you inserted into your  

PowerPoint slides will be displayed in the Image Palette as a collection of images.  You may use these images to edit existing slides or author new ones, as well as present them as an Image Palette presentation.

6) After you have made changes to the slides and images in your former 

      PowerPoint presentation, save your work as an OIV presentation by going to   

      the "File" menu and selecting the "Save" option.  This will save your  

      presentation as a .prs file in the 2.6 format of the Offline Image Viewer, as 

      opposed to the PowerPoint format (.ppt).

 

Using a PowerPoint slide in the OIV:


You can also save a single PowerPoint slide as an image and then import it into your OIV presentation. 

1) Open the PowerPoint presentation that includes the slide(s) that you want to save as images and use in your OIV presentation.

2) After you have selected the desired slide, click the "Save As..." option from the "File" menu. 

3) In the "Save as type" field, you can select any one of the following from the drop-down menu: GIF, JPEG, or PNG.  We recommend choosing the JPEG format if the PowerPoint slides you are saving consist mostly of images rather than text.


4) Once you have named the image file, save it to an appropriate location on your computer or network.   


5) A pop-up window will ask: "Do you want to export every slide in the presentation?”  To export only the current slide, click "No".  If you click "Yes", each slide in your presentation will be saved as a separate file in a folder.

6) Launch the Offline Image Viewer program on your computer.  Open an existing presentation or start a new one. 

7) From the Image Palette in the OIV, select “Import local images”.  


8) In the pop-up window that appears, browse to the location on your computer where you saved your PowerPoint slide(s).


9) Select the PowerPoint slides and click Add.

Note: You may also drag and drop image files directly into the OIV, e.g. from your desktop into the Image Palette of an existing presentation, or directly into a slide with an image placeholder.


Uploading your OIV Slide Presentation to ARTstor:

Once you have compiled your Slide Presentation in the Offline Image Viewer, you may upload the slides to ARTstor online.  By uploading your slides to your Personal Collection in ARTstor online, you will be able to share them with others at your institution, whether using Shared Folders, the Image Group Print Preview, or stable URLs.  This will allow you to share your slide presentation with those users who do not have a copy of the OIV installed on their computer.  These users will be able to view your slides as an Image Group in ARTstor. 

Note:  You must have Instructor-Level Privileges with your Personal Collection enabled in order to use this feature.  
 

You have two options for uploading OIV slides to ARTstor.  You may select individual slides, or upload the entire slide presentation all at once. 

1. To select individual slides, use your mouse to click on the desired slides in the Slide Sorter pane.  Select one slide by clicking on it once to highlight it.  If you would like to select more than one slide at a time, hold down your “Ctrl” key while clicking on multiple selections.  To select several adjacent slides, click on the first slide, press the "Shift" key, and then click on the last slide in the sequence.  Once you have selected all of the desired slides, right-click with your mouse and click on the "Upload selected slide(s)" option from the shortcut menu.  You may also click on the "Upload selected slide(s) to ARTstor" icon in the upper left corner of the Slide Sorter pane. 


2. To upload all of the slides in your presentation at the same time, go to the "File" toolbar menu and select the "Upload All Slides" option. 

In either case, a new window will appear, prompting you to logon to your ARTstor account.  After entering your email address and password, click on the "Upload" button in the bottom right corner of this window to begin the upload process.  You may also click on the "Check space" button before uploading to confirm that you have enough space left in your Personal Collection storage cap (maximum 1 GB) to add these new slides.  If you do check the space, two numbers will appear in the left side of the window: the space required to upload the new images, as well as the space currently available in your Personal Collection.  Once you have uploaded your OIV slides, you can log onto your ARTstor account to categorize and catalog them within your Personal Collection.

During the upload process, your slides were added as images to your Personal Collection in a special category called "OIV slides."  Your slide presentation was also saved as an Image Group in your “My Work Folder”, under the title of your presentation's file name. Any text that you added onto the slides themselves will be imported into the Description field in the data record for the corresponding Personal Image.  This means that any text that you added to your presentation slides will now be searchable by keyword in ARTstor.   


You have several options for sharing your OIV slide presentation once you have uploaded it to ARTstor.  Since the slides were saved as an Image Group, you have all of the options for sharing that are normally available for ARTstor Image Groups.  To share the presentation using a Shared Folder, simply copy the group of slides - which are saved into your private “My Work Folder” by default - into a different Shared Folder.

Uploading your OIV Image Palette Images to ARTstor:

It is possible to upload your local images from the OIV’s Image Palette to your Personal Collection of images in ARTstor online.  This will allow you to share your local images with ARTstor content in the same online environment.  

Note:  You must have Instructor-Level Privileges with your Personal Collection enabled in order to use this feature.  
1) Select the desired images in your Image Palette with your mouse.

2) After making your choices, right-click with your mouse and then select the "Upload selected image(s)" option from the shortcut menu.  You may also click on the "Upload selected image(s)” icon in the upper left corner of the Image Palette pane.

N.B.  You may only upload your local images to ARTstor.  If you try to upload an image that you downloaded from ARTstor back to ARTstor online, you will receive an error message.
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